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CarSim 8.0 is a significant update that provides improvements in the existing browser and GUI, vehicle 
models, documentation, animator, and file import/export capabilities. There are also many minor bug 
fixes and miscellaneous improvements. This technical memo highlights the improvements. 

More Examples 
Nearly all of the major new features are demonstrated in examples in the installed database to help you 
learn to use them. The sidebars for most examples also contain notes describing interesting details of each 
simulation. 
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In the installed example database in the category “* CS 8.0 COSIN/FTire” under the Datasets menu, an 
example is provided to illustrate CarSim 8.0’s support for the tire model “FTire” from the COSIN 
company. Although FTire support has been integrated into CarSim, FTire is a separately licensed product. 
The FTire license must be obtained from COSIN. 

The category “* CS 8.0 Encrypted Parsfiles” contains several examples illustrating data encryption. Users 
of CarSim 8 can encrypt vehicle or test procedure data so that another user who receives the encrypted 
parsfiles can use, but not see, the contents of the file. A user of encrypted data can still override or replace 
any elements of the encrypted data. This feature promotes cooperation between CarSim users at OEM’s 
and suppliers, for example. 

The category “* CS 8.0 Live Animator and Plotter” contains an example using a new output screen that 
displays “live” data during a run in several forms: animation, plotting, gauges, and dynamic displays of 
variable values.  

The category “* CS 8.0 Motion Ratios from Tables” contains an example illustrating the use of non-linear 
tables describing the compression of a spring as a function of suspension travel. CarSim 8 supports tables 
for all mechanical ratios for springs, dampers, and jounce and rebound stops, as well as all compliances. 
These are advanced features needed by relatively few users, so the browser supports only linear 
coefficients. However, each compliance and ratio has a complete table function available if needed. 

The category “* CS 8.0 New Vehicle Shapes” has several examples displaying some new animator shapes 
provided with CarSim 8.0. Two shapes, a “European Van” and “Utility Truck” offer additional vehicle 
types in common use. One example shows an agricultural tractor, with a front axle that pivots in roll and 
simulates a rigid rear suspension. Another shows a method to use CarSim 8.0’s math models to simulate a 
three-wheeled utility truck of a type seen in many parts of the world. 

The category “* CS 8.0 Road Roughness” contains an example illustrating a new CarSim function to 
provide roughness input to the vehicle models without the need to create complicated road geometry sets. 
A table of roughness data, which may represent actual measured road samples, is defined for each wheel 
track. The roughness is added to the surface profile of the road at each front tire contact, then added to the 
rear tire contacts after a time delay based on the vehicle speed and wheelbase. The roughness sample is 
automatically windowed and looped to provide continuous roughness input. 

The category “* CS 8.0 Traffic and Sensors” contains examples illustrating multiple moving traffic 
objects and the use of on-vehicle sensors to detect the presence, position, and motion of objects in traffic 
and the environment. The capability to add moving objects has been offered in CarSim for several years. 
However, in CarSim 8.0, the browser has new features to simplify the process of adding these objects and 
specifying their motion. The implementation of sensors (radar, lidar, ultrasonic, etc.) directly in CarSim is 
new, and requires an optional feature license. However, users can still implement systems like sensors 
using Simulink, LabView, or other methods of extending CarSim, as has been the case in the past. 

The category “* CS 8.0 Variable Width Roads” has examples illustrating a new feature of the CarSim 3D 
road model. With variable width roads, the browser now supports a process for easily describing road 
geometry along paths that are not parallel to the centerline, such as merge and turning lanes. It is also 
efficient for describing 3D features that “wander” laterally along the length of the road, such as an off-
road ditch or ruts that are worn into a pavement. 

Improvements in the Browser (CarSim.exe) 
Most CarSim users spend more time interacting with the CarSim GUI (the database browser) than any 
other part of the software. This update includes some significant improvements. 
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Expanded Management of Multiple CarSim Databases 
In CarSim 8.0, a number of important options have been added to the File menu item to assist in 
managing data. 

The Recent Databases menu item allows you to switch between a current database and one of up to 10 
recently opened databases. 

The “Consolidated Parsfile” is a new file type that CarSim can create to transfer data between databases 
or users. The consolidated parsfile (file type extension .cpar) contains everything included in an 
expanded parsfile plus embedded copies of other linked files (primarily animator shapes and audio files). 
When you load a .cpar file, all the additional information is automatically added to your database. 

Three new options have been added under the File menu item to create new databases. First, you can 
automatically create a new empty database. The empty database contains no data except one placeholder 
dataset in each library. Use this option when you have Expanded Parsfiles or Consolidated Parsfiles that 
you would like to have in a database separate from other data. Second, you can create a new database 
from a selected dataset. This process automatically generates a .cpar file for the selected dataset, 
creates an empty database, and loads the .cpar. The library tool supports the same process, with the 
additional option of selecting multiple datasets. Finally, you can create a new dataset from an existing 
.cpar file. This option is normally selected when another CarSim user has given you a .cpar to use, or 
when you want to move a number of datasets to another database. 

Data Encryption 
Datasets in any library except the Run Control library can be encrypted. A user of an encrypted dataset 
cannot view the data in the GUI. The data is contained in the files CarSim generates in an encrypted form 
that is not readable. Encrypted data values are password protected and can be decrypted by a user who 
knows the password. 

The Resources Folder 
A new folder has been added within the CarSim programs folder. It contains all the animator information 
and some other files used in the example datasets. This means your databases don’t need to contain copies 
of animator files unless you create your own shapes or receive new shapes from someone else (as in a 
.cpar file). This significantly reduces the size of databases by eliminating multiple copies of the same 
support files. 

The Procedures Screen 
A new library called Procedures has been added. Using this library you can specify all the information 
for a simulated test including driver controls, environment, start and stop location and time, simulation 
parameters, and plot setups in one place. Using Procedures you can create completely portable test 
definitions, so a run can be made simply by selecting a vehicle and a procedure, then clicking the Run 
button. 

Copy and Link Dataset 
The drop-down controls for selecting datasets within a library now include the option Copy and Link 
Dataset. Selecting this option opens a dialog to specify the name of a new dataset in the linked library. 
That dataset is automatically generated and linked to the current dataset, saving several steps and lots of 
time as you build new datasets. 
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Automatic Output Variable Selection 
On making a run, all linked files are first scanned to find references to output variables in plot setups, 
animator screens, etc. It is no longer necessary to create lists of output variables when you want a limited 
set. Options still exist to write everything to the output, or write only a specified limited set and ignore the 
results of the scan. 

The Generalized Symbol Stack 
The browser has the capability to define symbols that can be replaced or incremented during the process 
of preparing data to send to the solvers or animation software. The symbols can be defined within a 
parsfile, and are available to all of the parsfile's linked child datasets, but are not available to parent 
datasets linking to it. Symbols can also use other symbols in their definition. 

This makes it possible to produce groups of related but unique VS command variables with a single 
command. 

More Improvements 
• Three new screens have been added to define and control audio samples for generating sounds 

representing, for example, engine, wind, and tire noise. 

• New options have been added to the Preferences screen to set up default behaviors for many 
features that you don’t change very much, such as numerical integration parameters. 

• Options have been added to automate the generation of images on various vehicle and road screens 
to show a picture of the object as it will appear in animations. 

• A new screen supports control of features like tire force arrows, brake lights, and shadows. 

• Several new screens support automatic creation of moving and fixed objects (traffic vehicles, 
pedestrians, trees, etc.) 

• Screens were added to specify variable width roads. 

• Numerous minor improvements on many screens offer more interactive user control, such as 
checkbox options and slider bar control over display appearance. 

• A progress bar appears for lengthy operations. At the same time, the browser is sometimes 
minimized to speed up the operation by eliminating screen refreshes. 

• Undo has been extended to preserve information from the time you launched CarSim. If you return 
to a dataset screen, changes made in previous visits can still be undone and redone, up to the state 
of the dataset when you started the CarSim program (carsim.exe). 

Improvements in Documentation 
CarSim includes extensive documentation, covering all screens in the GUI, reference manuals for major 
parts of the software such as the animator and plotter, and technical memos covering specialized uses of 
the software. The CarSim Help folder contains over 80 PDF files, and most of these are accessible from 
the Help menu. Some are new, to describe new screens and features in the software (e.g., sensors and 
traffic). Most of the documents that existed in previous versions have been updated to include new 
capabilities and features. In particular, the CarSim Quick Start Guide has been completely rewritten and 
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is highly recommended for all users, because it describes new methods for working in the database that 
are much quicker than was possible in earlier versions. 

 The Help menu now has the command Search Help, which brings up a window in Adobe Reader for 
searching the entire set of CarSim documents. This is the primary tool for finding information quickly 
from over 1000 pages of documentation provided with the software. 

Improvements in the Math Models 
Sensors and Traffic 
The models have built-in support for static and moving objects such as traffic vehicles, and sensors that 
can detect the range and positions of these objects. 

• Up to 99 moving objects (representing vehicles, animals, children, etc.) can be added at runtime.  

• Automatic recycling of objects can produce the effect of large numbers of traffic vehicles with 
relatively few specifications. 

• Up to 20 sensors on the vehicle can detect the moving objects.  

• Outputs are available for animation, plotting, and export for interactions between sensor and 
objects. Outputs include distance, heading to left edge, right edge, closest point, magnitude, yaw, 
pitch. Objects can be rectangular or cylindrical.  

• Moving objects can block the sensing of other objects (occlusion).   

More Non-linear Elements 
All suspension compliances and mechanical ratios for springs, dampers, and jounce and rebound stops are 
now supported by table functions. The table functions include spline, linear interpolation, linear 
coefficient, and constant (e.g., 0.0) options. 

Internal Tire Models 
A parameter has been added for the unloaded radius of a tire. This radius is used along with the vertical 
tire stiffness, vertical load, and the effective rolling radius to make minor improvements in calculation of 
tire deflection. The changes improve the calculation of road load power and fuel efficiency. 

COSIN FTire Model 
The COSIN FTire model is now supported fully by the CarSim Tire screen. FTire is a detailed tire model 
supplied by the COSIN company. FTire is a separately licensed product, and a license must be obtained 
from COSIN to use this feature. 

Powertrain Model Improvements 
Several updates to the powertrain model have been made. 

• A major improvement was made in treating the manual clutch. A degree of freedom is now 
removed when the clutch is engaged.  

• A major improvement was made in treating the lockup clutch in a hydraulic torque converter. A 
degree of freedom is now removed when the clutch is engaged.  
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• Clutch torque capacity (for both manual clutch and lockup clutch) can be treated with 1st order 
dynamic delay with two time constants (engaging and disengaging). The On/off state of the 
dynamic torque delay can be selected by an optional switch parameter.  

• Maximum torque capacity of the lockup clutch in the hydraulic torque converter is either a user 
parameter or external command (via Simulink or VS Command). (In past versions this was fixed 
internally at 600 N-m.)  

• A degree of freedom was added for the transmission input shaft when the clutch is disengaged with 
neutral gear position.  

• A degree of freedom was added for the driveline torsional compliance. The additional degree of 
freedom is a twist in the middle of transmission output shaft (the transmission output shaft is split 
into two parts and its inertia is equally distributed between them). Those two inertial bodies are 
connected with torsional spring and damper.  

• The torsional spring and damper for the driveline compliance (item above) is automatically 
calculated by two new user parameters, natural frequency and damping ratio of driveline. This 
compliance represents the torsional flexibility of the entire driveline.  

More Improvements 
Numerous minor improvements include: 

• Initialization of solid axles and twist beams now supports asymmetric wheel center heights. 

• An output variable for "brake apply status" is added to control brake lights. Speed controller action 
is also triggered by this variable (in past versions it controlled by wheel cylinder pressure).  

• Added scale factor for acceleration of gravity. 

• Tire lag dynamics can be disabled by setting relaxation length parameters to zero. 

• New table types include 2D spline interpolated tables and step-change tables. 

• Error dialog suppression prevents interruption of large batch runs if an error occurs. 

• Options were added to activate Import Variables for use in VS commands without interfering with 
the array of import variables received from Simulink. 

• Removed input line length limit when reading parsfiles. 

More VS API Functions  
More internal functions have been added to the API in support of advanced users. 

• New VS API functions were added involving 3D road access. Access for X-Y-Yaw allows external 
index J (because internal tables use design different from all other VS tables):  

o vs_road_yaw_j  
o vs_get_road_xy_j  

• New VS API function to install external C functions and apply them, allowing multiple extensions 
to be installed independently. New API functions are:  

o vs_install_calc_function  

o vs_install_echo_function  
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o vs_install_setdef_function  

o vs_install_scan_function  

o vs_install_free_function  

• New VS API function vs_define_indexed_parameter_array to install indexed 
parameters at runtime.  

• Solvers now generate error if there is an attempt to redefine an existing variable via VS command 
or API. 

Improvements in the Animator 
The animator can be launched via command line to a specified size, to support easy generation of static 
images to paste into browser datasets.  

The animator supports multiple arbitrary search paths for assets, which the browser utilizes for the new 
PROG\Resources area.  

Bug Fixes and Errata 
• Bugs fixed in output of camber angles for twist beams, user options for defining jounce options for 

solid axles and twist beams. 

• Fixed bug in rolling resistance scale factor for Pac52 models (was ignored). 

• A bug in the speed controller definition was fixed. This bug made it difficult to switch successfully 
between open- and closed-loop control modes. 

• A calculation bug for the output torque of the lockup clutch in hydraulic torque converter was fixed. 

• A discrepancy was fixed in which the driver model extrapolated X-Y road geometry beyond the 
range of the tabular data differently from the methods used to calculate road geometry. 

Compatibility: Known Issues vs. CarSim 7.11 

Keyword Changes 
New features in CarSim 8.0 necessitated changes to keywords for several parameters. A list of all 
replaced keywords appears in the next section, “New and Revised Keyword List”. 

These primarily involve parameters that formerly were defined only as linear coefficients that now are 
supported with full non-linear table capability: compliances and suspension mechanical ratios. 

Improvements in other features have added new keywords. The database update process has been 
designed to make keyword changes automatically. However, there are cases that can’t be handled in the 
update process. When a database is updated, CarSim can automatically revise keywords for parameters 
that appear in context in specific locations. For example, all the mechanical ratios on the Suspension 
Compliance screens are simply read and rewritten with new model keywords. Advanced users may use 
miscellaneous data fields or generic screens to override keywords entered in their normal context. By the 
nature of these generic data entries, CarSim can’t infer from the context what they might contain. This 
includes VS Commands that use the affected keywords. 
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Unfortunately, these keyword substitutions must be made through a search and replace process. Using a 
good text editor with a search and replace process that allows searching of multiple files can make the 
process relatively simple.  

Speed Controller Setting 
An oversight in the development of the speed control was corrected. Formerly, the parameter identifying 
the speed controller mode was not set properly by the math model during events that changed the control 
mode. In version 7.01, a workaround was added to the browser behavior that forced the speed controller 
option to be updated whenever a new event was read. This was an incomplete solution, and switching 
back and forth between open-loop and closed-loop control still required the speed controller option 
parameter (OPT_SC) to be explicitly set in the miscellaneous data field on the events screen. 

The speed controller has been revised to allow switching between control modes based only on the 
selection of the controller type, using the drop-down list on the events screen. This means that speed 
control information must be linked under the drop-down control, and not under one of the miscellaneous 
links on the events screen. If you have events screens that set OPT_SC explicitly you will need to check 
that the drop-down control setting is correct and remove the unneeded reference to OPT_SC. 

Speed Controller Interaction with Braking  
When the speed controller is set to use open-loop braking, rather than to use closed-loop braking to follow 
a decelerating speed profile, a brake application automatically turns off the speed control. In CarSim 
versions prior to 8.0, the speed control was turned off when any wheel cylinder pressure or the master 
cylinder pressure was greater than zero. This made it impossible to use controllers that function by 
applying brakes, such as many stability controls, while using the closed loop speed control. It also meant 
that the speed control could not be switched into closed-loop mode after a brake application, because 
brake cylinder pressure changes are subject to a differential equation, which means their values can 
approach but never reach zero unless explicitly set. 

These problems were remedied by creating a new output variable, BK_STAT, to indicate the status of the 
brake control. Bk_Stat has a value of 0 when the brakes are not applied and a value of 1 when a brake 
control input value is non-zero. The setting is only determined by the control inputs Pbk_Con (the 
master cylinder pressure) for the basic brake model, or F_Pedal (the brake pedal force) for the brakes 
with detailed booster and thermal effects, depending on which model is selected. 

Bk_Stat is also used to control illumination of brake lamps. 

Powertrain Performance 
Before version 8.0, the definition of clutch engagement for mechanical clutches in manual transmissions 
and torque converter lockup clutches in automatic transmissions prevented the clutch input speed and 
output speed from exactly matching, even when the clutch was defined to be fully engaged. The clutch 
logic has been improved so the input and output speeds match when clutch lockup occurs. This means 
you can expect small performance differences between version 8.0 and earlier CarSim versions. 

Animator Field of View 
An obsolete parameter has been retired. Prior to version 8.0, the Animator: Camera Setup screen had a 
field labeled “Field of View (v3.0)”. The definition of the camera field of view in old versions of 
SurfAnim (the animator program) was inconsistent with standard video definitions. After SurfAnim 3.0, 
the definition of field of view was corrected. The old parameter was retained for backward compatibility 
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with datasets that originally used SurfAnim 3.0. That version of SurfAnim was superseded in February, 
2007, with the release of CarSim 7.0. If you have legacy data, or if you use CarSim 8.0 to update version 
6 data, you may need to set a field of view parameter for datasets in the Animator: Camera Setup 
library. You can find a field of view setting you prefer by running the animation and adjusting the slider 
control for field of view until you find a setting you like, then reading the value from the control and 
typing it into the “Field of View” data field on the screen. 

Road Roughness Profile 
CarSim version 7.xx had an undocumented feature similar to the road roughness profile in CarSim 8. In 
version 7.xx, the math model had the option to apply a Hanning window filter to create a continuous 
looped table, as is done in version 8.0 on the Road: Roughness Profile screen.  

The keyword Z_PROFILE_HANNING specified the amount of the profile affected by the Hanning 
window. This capability was used in example datasets for the driving simulator. That capability was 
removed in version 8 to avoid conflict and confusion with the same feature being available in the browser. 

If you have datasets from version 7.xx that use this feature, you should copy the profile data into the 
Road: Roughness Profile screen and apply the window filter there. The processed profile data can then 
be passed to the version 8.0 math models to obtain the same results. 

New and Revised Keyword List 
Table 1 lists keywords for compliance coefficients that have been replaced by table functions. Each table 
function supports the full array of non-linear capabilities, and gain and offset. Compliances are seldom 
defined with nonlinear tables, so browser support is available only for coefficients to avoid extra 
complications in the browser for most users. Those needing non-linear descriptions of compliance effects 
can define them using generic table screens. In each case, “()” indicates an indexed parameter. 

Table 1: Compliance Coefficients now supported by table functions 

Old Name New Name Table Root Keyword 
CC_FX()  CC_FX_COEFFICIENT()  CC_FX_ 
CC_FZ() CC_FZ_COEFFICIENT() CC_FZ_ 
CD_MY()  CD_MY_COEFFICIENT() CD_MY_ 
CI_FY() CI_FY_COEFFICIENT() CI_FY_ 
CI_MZ() CI_MZ_COEFFICIENT() CI_MZ_ 
CS_FY() CS_FY_COEFFICIENT() CS_FY_ 
CS_MZ() CS_MZ_COEFFICIENT() CS_MZ_ 
CT_FX() CT_FX_COEFFICIENT() CT_FX_ 
CT_FZ() CT_FZ_COEFFICIENT() CT_FZ_ 
C_LAT() C_LAT_COEFFICIENT() C_LAT_ 
C_LONG() C_LONG_COEFFICIENT() C_LONG_ 
C_LAT_AXLE() C_LAT_AXLE_COEFFICIENT() C_LAT_AXLE_ 
C_LONG_AXLE() C_LONG_AXLE_COEFFICIENT() C_LONG_AXLE_ 
 

Table 2 lists keywords for suspension component mechanical ratios that have been replaced by table 
functions. Each table describes the deflection of a component as a function of vertical wheel displacement 
(jounce). Each table function supports the full array of non-linear capabilities, and gain and offset. 
Mechanical ratios are seldom defined with nonlinear tables, so browser support is available only for 
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coefficients to avoid extra complications in the browser for most users. Those needing non-linear 
descriptions of compliance effects can define them using generic table screens. In each case, “()” 
indicates an indexed parameter. 

Table 2: Suspension Mechanical Ratios now supported by table functions 

Old Name New Name Table Root Keyword 
R_DAMPER()  CMP_DAMP_COEFFICIENT()  CMP_DAMP_ 
R_SPRING() CMP_SPR_SEAT_COEFFICIENT() CMP_SPR_SEAT_ 
R_JNC_STOP()  CMP_JSTOP_COEFFICIENT() CMP_JSTOP_ 
R_REB_STOP() CMP_RSTOP_COEFFICIENT() CMP_RSTOP_ 
 

Table 3 lists new parameters that didn’t exist prior to CarSim 8.0. In each case, “()” indicates an indexed 
parameter.  

Table 3: New Parameter names 

Parameter Name Notes 
DRIVELINE_FREQ  First torsional mode natural frequency of the driveline 
DRIVELINE_ZETA Damping ratio of the driveline first torsional mode 
ENGINE_STALL_DAMP  Damping coefficient applied when engine stalls 
R0() Free (unloaded) radius of a tire 
RR_FX() 1 if used, otherwise 0 
R_GRAVITY Scale factor for acceleration of gravity 
TSTART_SPEED_CTRL Time to start using a speed control table 

 

Table 4 lists new table functions that didn’t exist prior to CarSim 8.0, and don’t replace linear coefficients 
as outlined in Table 1 and Table 2. 

Table 4: New Table Function names 

Table Root Keyword Name Notes 
M_TRANS_ROT  Torque vs angular deflection of the driveline. Provided as an alternative 

to DRIVELINE_FREQ for specifying driveline torsional stiffness 
M_TRANS_AV Torque vs angular deflection rate of the driveline. Provided as an 

alternative to DRIVELINE_ZETA for specifying driveline torsional 
damping 

 

As mentioned in the previous section, version 7.xx used the keyword Z_PROFILE_HANNING to specify 
the amount of road roughness profile affected by a Hanning window. In CarSim 8, this capability has 
been put into the browser (in the Road: Roughness Profile screen) and removed from the VS solvers.  
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